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This section provides an overview of the National Transit Database (NTD) Monthly reporting requirements, including the 
following: 

What is the National Transit Database?  
This section provides the legislative basis for the NTD reporting system. 

Changes in 2008 Reporting 
This section summarizes the changes in reporting requirements implemented in Calendar Year (CY) 2008. 

Who Reports, What to Report, How to Report, When to Report, and Where to Report  
This section provides answers to basic reporting questions. 

Data Validation Tools and Validation Checks 
This section provides a description of reports and checks used to help identify data completeness and reasonableness. 

Reference Information 
This section presents key definitions as well as reference resources and publications for further detail on issues related to 
reporting. 
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What is the National Transit Database? 

The National Transit Database (NTD) is the Federal Transit Administration's (FTA's) primary national database for statistics 
on the transit industry. Recipients of FTA’s Urbanized Area Formula Program (Section 5307) and Other than Urbanized Area 
Formula Program (Section 5311) grants are required by statute to submit data to the NTD. Over 650 transit agencies and 
authorities file annual reports to FTA through the internet-based reporting system. Each year, NTD performance data are 
used to apportion over $4 billion of FTA funds to transit agencies in urbanized areas (UZAs). Annual NTD reports are 
submitted to Congress summarizing transit service and safety data. 

The NTD is the system through which FTA collects uniform data needed by the Secretary of Transportation to administer 
department programs. The data consist of selected financial and operating data that describe public transportation 
characteristics. The legislative requirement for the NTD is found in Title 49 U.S.C. 5335(a): 

SECTION 5335. NATIONAL TRANSIT DATABASE. 

(a) NATIONAL TRANSIT DATABASE — To help meet the needs of individual public transportation systems, the United 
States Government, State and local governments, and the public for information on which to base public transportation 
service planning, the Secretary of Transportation shall maintain a reporting system, using uniform categories to 
accumulate public transportation financial and operating information and using a uniform system of accounts. The 
reporting and uniform systems shall contain appropriate information to help any level of government make a public 
sector investment decision. The Secretary may request and receive appropriate information from any source. 

(b) REPORTING AND UNIFORM SYSTEMS —The Secretary may award a grant under section 5307 or 5311 only if the 
applicant, and any person that will receive benefits directly from the grant, are subject to the reporting and uniform 
systems. 

The NTD reporting system evolved from the transit industry initiated Project FARE (Uniform Financial Accounting and 
Reporting Elements). Both the private and public sectors have recognized the importance of timely and accurate data in 
assessing the continued progress of the nation's public transportation systems. 

Funding for Agencies Serving Urbanized Areas under 200,000 Population  
The NTD data are also used in the formula allocations of Federal transit funds. Prior to the Safe, Accountable, Flexible, and 
Efficient Transportation Equity Act: A Legacy for Users (SAFETEA-LU), only NTD data for urbanized areas with populations 
of 200,000 or more were used. With the passage of SAFETEA-LU, NTD data for urbanized areas with fewer than 200,000 
population are also used in the allocation of Federal transit funding. 

SAFETEA–LU directed that there be a one percent takedown from the funds made available under Section 5307. This 
takedown amount will be for apportionment under the new Small Transit Intensive Cities (STIC) formula. Under the formula 
for STIC, funds are apportioned to UZAs with a population less than 200,000 that meet or exceed the average level of 
service for all UZAs with populations between 200,000 and 1,000,000.  

SAFETEA–LU also establishes new Growing States and High Density States formula factors (Section 5340) to distribute 
funds to the section 5307 and section 5311 programs. One-half of the funds are made available under the Growing States 
factors and are apportioned by a formula based on State population forecasts for 15 years beyond the most recent Census. 
Amounts apportioned for each State are then distributed between UZAs and other than urbanized areas based on the ratio 
of urbanized / other than urbanized population within each State. The High Density States factors distribute the other half of 
the funds to States with population densities in excess of 370 persons per square mile. These funds are apportioned only to 
UZAs within those States. 

For more information on SAFETEA-LU, contact your regional administrator or go to www.fta.dot.gov. 

Changes in 2008 Reporting 

In its ongoing efforts to improve upon the NTD Internet Reporting system and to be responsive to the needs of the transit 
agencies reporting to NTD and the transit community, FTA continues to refine and clarify reporting requirements and Internet 
Reporting. 

Reporting changes for the 2008 NTD are highlighted below. Specific changes are discussed in detail in the applicable 
sections of this manual. 

Reporting Form Changes 
The following exhibit describes changes by reporting form. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G503
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G500
http://www.fta.dot.gov/
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Exhibit 1 — CY 2008 Reporting Changes and Highlights 
Reporting Requirements — Five Changes 
1. Clarification of the requirements for reporting monthly unlinked passenger trips. FTA requires 100% counts if available and 

reliable. If not available or reliable, the application of a methodology developed for estimating monthly trips is allowed and 
does not need to be the same as the one used in Annual reporting. However, the two methodologies cannot be biased in 
relation to each other. 

2. Validation Reports are available to identify potential issues with the data. Agencies are encouraged to run this report prior to 
submission. It lists all potential problems with the data. Agencies should address all issues by either changing the data or 
explaining why the data is correct as reported. 

3. Added incoming and outgoing correspondence capability for both the agency and Validation analyst. This capability is used 
for documentation of validation issues. 

4. The system will not allow the creation of monthly forms if the agency has an approved 9 or fewer vehicles reporting waiver. 
5. The system will not allow submission of incomplete reports. All data items, unlinked trips, vehicle revenue miles, vehicle 

revenue hours, vehicles operated in maximum service, and typical days operated are required and cannot be blank upon 
submission. 

Mode Service Operated form (MR-10) — One Change 
1. The reporter is allowed to add or delete a mode/type of service. Deletion of a mode requires completion of a form note 

explaining why the mode is being deleted and the Validation analyst must either approve or deny the deletion. 
Ridership Activity form (MR-20) — Five Changes 
1. Column a is now labeled Unlinked Passenger Trips (UPT). 
2. The system will not allow data to be entered for a new month until the prior months have been submitted.  
3. Any zero data will have to be explained by the agency via the e-File tab. 
4. Clarification for the Edit Date button functionality. Once the data has been entered on the Ridership Activity form (MR-20), 

the reporter must click the Edit Date button and then click the Save button to ensure that the information is submitted 
properly.  

5. Added form scripts to notify the reporter of missing data prior to submission. 

Who Reports 

Transit agencies that receive or benefit from Urbanized Area Formula Program (UAF) funds and report to the NTD must 
submit or coordinate the submittal of the NTD Monthly report. These transit agencies or organizations are generally referred 
to as recipients or beneficiaries. 

Recipients and Beneficiaries of Urbanized Area Formula Program Grants  
Transit agencies that are recipients or beneficiaries of FTA Urbanized Area Formula Program (UAF) funds and that manage 
transit activities must submit the NTD report, regardless of whether they directly operate (DO) or purchase (PT) their transit 
services. These recipients or beneficiaries can be public entities directly operating services or contracting for all or part of the 
total transit service provided. The transit agency must report all of the service they provide or purchase, excluding services 
provided under demonstration grants or test projects funded through the Congestion Mitigation and Air Quality (CMAQ) 
program or other funds transferred into the Urbanized Area Formula Program (UAF). The following are typical NTD reporters 
and requirements for recipients and beneficiaries of Urbanized Area Formula Program (UAF) funds. 

Public Transit Agencies 
Public transit agencies must submit or coordinate a NTD report through the life of the grant and / or the life of the capital 
equipment obtained through the grant (continuing requirements). If a transit agency does not spend funds from the grant for 
either capital expenses or operating assistance for the year, the transit agency must still file a NTD report if the grant is still 
active or capital equipment still has remaining useful life. 
 

Example 1 — Continuing Requirements 
A transit agency purchases a vehicle with Urbanized Area Formula Program (UAF) funds.  
The vehicle, a 40-foot bus (MB), has a useful life of 12 years or 500,000 miles.  
The transit agency must report under the NTD program throughout the useful life of the vehicle regardless of whether or not the 
transit agency receives Urbanized Area Formula Program (UAF) funds during a particular year. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G123
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G97
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G371
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G75
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G301
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Operators of Purchased Transportation Services  
Private carriers operating purchased transportation (PT) services that provide public transportation services under contract to 
recipients or beneficiaries of Urbanized Area Formula Program (UAF) funds must report data to the public transit agency for 
inclusion in the public transit agency's NTD Annual report. These private providers must supply the purchased transportation 
data to the buyer for inclusion in the buyer’s report and will no longer submit a separate NTD Annual report for that data. The 
data pertain only to the services under contract. This applies to almost all private providers.  

Contractual agreements between public NTD reporting agencies for purchased transportation (PT) services can either be 
reported by the seller or buyer of service as directly operated (DO) service. Therefore, when a public agency is the buyer of 
service and is reporting purchased transportation (PT) service on behalf of the pubic agency which is selling service, the 
seller must supply the data to the buyer so that it is reported in the buyer’s report as directly operated (DO) service. 
Additionally, when the seller is reporting the service in their report, the purchased transportation (PT) services are reported 
as directly operated (DO) service. 

Consolidated NTD Reporters 
Consolidated NTD reporters are a collection of transit agencies filing one report. One reporter may file a consolidated report 
on behalf of other reporters if it is easier to collect and control the quality of the data. This often occurs when one transit 
agency coordinates the development and funding of public transportation services in an area. Transit agencies filing a 
consolidated report must operate within the same urbanized area (UZA).  

Transit agencies that wish to file a consolidated report must submit a request to FTA in writing. Such requests for 
consolidations are subject to FTA approval and must include the following:  
• Name of the transit agencies to be included 
• Fiscal year end dates for each transit agency 
• Previous NTD identification numbers (NTD ID) of the transit agencies 
• Date for the first consolidated report. 

Nine or Fewer Vehicles Waiver 
Transit agencies with nine or fewer vehicles in annual maximum service (VOMS) that operate only non-fixed guideway 
(NFG) systems are not required to file a NTD Monthly report. The system will not generate forms for agencies with an 
approved 9 or fewer vehicles waiver. 

Voluntary Reporters  
Voluntary NTD reporters are those transit agencies, public or private, which are not recipients or beneficiaries of Urbanized 
Area Formula Program (UAF) grants.  

Public Carriers 
Public carriers that do not use or do not have continuing requirements of Urbanized Area Formula Program (UAF) or Other 
than Urbanized Area Formula Program funds may voluntarily submit a complete NTD report. 

Private Carriers 
Private carriers that are not under contract to an Urbanized Area Formula Program (UAF) or Other than Urbanized Area 
Formula Program funds recipient or beneficiary may voluntarily submit a complete NTD report. 

FTA encourages all voluntary public and private providers of public transportation services to report their services to the NTD 
program. Through the submission of complete and accurate reports, the NTD will be more reflective of the entire transit 
industry. Voluntary reporters that chose to report a complete NTD report are required to complete Safety and Security (if 
applicable) and NTD Monthly reports. 

What to Report 

The NTD Monthly report consists of a series of forms that collect data providing FTA with monthly trends in ridership and 
service supplied throughout the year. It must contain all the public transportation service, including complementary 
paratransit services required by the Americans with Disabilities Act of 1990 (ADA), which the transit agency provides or 
purchases. 

For purchased transportation (PT) service, the report must contain data only for those services under contract. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G367
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G503
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G292
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G521
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G281
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G526
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G371
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G367
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G373
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G96
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G96
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G29
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
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Reporting Modules and Forms 
All agencies are required to submit data on a monthly basis. The following exhibit presents a summary of NTD Monthly 
reporting requirements. 
 

Exhibit 2 — Summary of NTD Reporting Requirements 
NTD Monthly Report 
Mode Service Operated form (MR-10) All reporters 
Ridership Activity form (MR-20) All reporters 

Calendar Year Data 
Unlike the NTD Annual report, which covers the 12-month fiscal year period, the data in the NTD Monthly report covers a 12-
month period corresponding to the calendar year. 

How to Report 

This section describes the following: 
• NTD identification number (NTD ID) 
• Internet reporting 
• Reporting format 
• Purchased transportation (PT). 

The NTD Identification Number 
Each transit agency is assigned a unique FTA NTD identification number (NTD ID) to be used in the NTD report and all 
correspondence. Each transit agency must have a NTD identification number before filing a report. If you are a new reporter 
and do not have a NTD identification number, please refer to the New Reporters discussion in the Annual Reporting Manual.  

Internet Reporting 
All required forms are completed using Internet Reporting which is accessible from the NTD website at 
www.ntdprogram.gov. Completing the Mode Service Operated form (MR-10) automatically generates the required Ridership 
Activity forms (MR-20) for the transit agency. 

This manual contains all information necessary to complete the NTD Monthly report using Internet Reporting. See the 
Internet Reporting section of this manual for specifics. FTA provides Internet Reporting user names and passwords to transit 
agencies.  

Reporting Format 
Transit agencies must submit their reports via the Internet Reporting system. A transit agency must file a complete report by 
the report due date. See the When to Report section below to determine your due date. 

General Formatting Rules  
Data reported must adhere to the following rules: 
• Follow rounding directions for each form 
• Unless otherwise indicated, report data as whole numbers 
• Use four digits for year entries. 

Internet Reporting incorporates these rules, formatting data automatically when you complete a cell entry. 

Reporting Purchased Transportation  
Purchased transportation (PT) service is service provided to a public transit agency or governmental unit from a public or 
private transportation provider based on a written contract. A contractual relationship exists only if all the following criteria are 
met: 
• The seller is obligated in advance of the time the service is furnished to provide the operations for which the operating 

statistics are being reported for a specific monetary consideration. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G292
http://www.ntdprogram.gov/
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G371
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G372
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G367
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G427
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G268
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• A written agreement exists that specifies the contractual relationship for the time period and the specific service 
generating the operating statistics included in the NTD report. 

• The written agreement is signed by authorized representatives of both the buyer and the seller, and should detail the 
services to be provided, and the nature and amount of the monetary consideration. 

Granting a transportation provider permission to operate certain services through a franchise or license does not, in itself, 
constitute purchased transportation (PT). Also, management services contracts, in which all or some personnel or services 
are provided to manage or operate the transit agency, are not purchased transportation (PT). Generally, the service is part of 
the public transit agency’s directly operated (DO) service. 

When to Report 
 

Exhibit 3 — NTD Monthly Requirements and Timelines 
Form Name Form Purpose Reporting Frequency Forms Submitted 
Mode Service Operated form (MR-10) Gives NTD the information needed 

to generate the ridership activity 
forms the transit agency will need 
to complete for the reporting year. 

Annually (January) and 
when a mode or type 
of service is added or 
deleted  

One per transit 
agency 

Ridership Activity form (MR-20) Provides NTD with monthly 
information on service provided by 
the transit agency. 

Monthly  One per mode / type 
of service (TOS) 
combination 
 

Monthly Reporting Due Dates    
Month 
January 
February 
March 
April 
May 
June 
July 
August 
September 
October  
November  
December  

Due Date 
February 28 
March 31 
April 30 
May 31 
June 30 
July 31 
August 31 
September 30 
October 31 
November 30 
December 31 
January 31 of following year 

Failure to Report or Late Report  
NTD requires transit agencies to submit complete reports according to the due date schedule. Delinquent reports results 
from not submitting a report, submitting a late report, or not responding to validation inquires. Incomplete reports can no 
longer be submitted. As a result, your transit agency's data may not be included in the NTD. Furthermore, FTA may declare 
your transit agency ineligible to receive any Urbanized Area Formula Program (UAF) grants during an entire Federal fiscal 
year. This ineligibility applies to all transit agencies, regardless of the size of the urbanized area (UZA) served. 

A report is considered late if it is not submitted by the due date. Refer to Exhibit 3 — NTD Monthly Requirements and 
Timelines for due dates. 

The system will auto-generate a series of four e-mails sent per reporting due date: 

1. A reminder will be sent to the NTD Contact 10 days prior to the due date.  

2. A second reminder will be sent to the NTD Contact and CEO one day following the due date if no report has been 
received. 

3. A late notice will be sent to the NTD Contact and CEO three days following the due date if no report has been 
received.  

4. A Delinquency Notice will be sent to the NTD Contact and CEO fifteen days following the due date if no report has 
been received. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G69
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G225
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G204
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G503
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Please do not respond to these e-mails. These notices are auto-generated by the system the morning it is sent out, and 
should be disregarded if you submitted your report within the last few hours. 

Transit agencies are required to respond to validation inquiries. Failure to respond within the prescribed timeframe may 
result in a delinquent status, which may affect your Urbanized Area Formula Program (UAF) funding eligibility and the 
amount of funding the UZA receives. If your transit agency serves a UZA with a population of 200,000 or more, data will not 
be entered into the formula for selected formula statistics.  

Where to Report  

Transit agencies submit all NTD reports via Internet Reporting at the project's website, www.ntdprogram.gov.  

FTA assigns an NTD analyst to each reporting transit agency to assist reporters throughout the year. Please feel free to 
contact your NTD analyst if there are any questions, or if FTA can do anything to assist you in reporting. 
 

Exhibit 4 — NTD Contact Information 
Mailing Address  
You can write to the FTA NTD Project Office at the following 
address: 

Federal Transit Administration 
National Transit Database 
P.O. Box 457 
Merrifield, VA 22116-0457  

Please use the U.S. Postal Service for deliveries to this  
P.O. Box. 

Telephone 
Your NTD analyst and other NTD staff can be contacted by 
telephone on weekdays. For telephone information and 
assistance, call the FTA NTD Project Office at: 

703.462.5220 
The FTA NTD Project Office is open from 7:30 am to 5:30 pm 
(Eastern Time). If your NTD analyst is unavailable, you may 
use the voice-mail system and your call will be returned, or 
you may forward your call to another NTD analyst. 

Express Delivery Address 
Express deliveries can be made to the following address: 

Federal Transit Administration 
National Transit Database  
3040 Williams Drive, Suite 100 
Fairfax, VA 22031 

E-mail 
You can contact your NTD analyst by using the e-mail 
address located on the Transit Agency Home tab at: 

www.ntdprogram.gov 
Or contact your NTD analyst for individual e-mail addresses. 

Fax 
The FTA NTD Project Office also maintains a 24-hour FAX 
service. You may FAX correspondence to the FTA NTD Project 
Office at:  

703.462.5219 
An original of all faxed documents must also be mailed to the 
FTA NTD Project Office. 

Internet 
Finally, the FTA NTD Project Office manages a website at the 
following address: 

www.ntdprogram.gov 
NTD publications and reference documents are available on 
the FTA NTD website. 

Data Validation Tools and Validation Checks 

Data validation tools include reports in the Reports tab that show potential problems with the data. These problems may 
include: 
• Monthly variations in the data outside the ranges derived from the historic data reported by the agency (data outliers). 
• Identical data for successive months. 

Agencies are encouraged to change or explain the reason(s) for outliers using the form notes feature.  

For CY 2009, data validation will become an automated process. 

A form script is triggered if there is missing data when the Submit button is clicked. The agency is required to provide all 
missing data in order to submit the NTD Monthly report. 

Reference Information 

This section contains two items necessary to understanding NTD reporting: 
1. Transit terminology and parameters 
2. Reference documents. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/
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Transit Terminology and Parameters 
Reporting data for the NTD requires an understanding of the following transit concepts and terms: 
• Public transportation  
• Mode 
• Type of service (TOS) 
• Maximum service vehicles. 

Each of these terms is described in further detail in the sections that follow. 

Public Transportation 
The definition of public transportation is important because the purpose of the NTD is to collect information on public 
transportation. As defined in the Federal Transit Act, public transportation means transportation by bus (MB) or rail, or other 
conveyance, either publicly or privately owned, providing to the public general or special service (but not including school 
buses or charter or sightseeing service) on a regular and continuing basis. Public transportation is also synonymous with the 
terms mass transportation and transit. 

Public availability is a key part of the definition. Services defined as public transportation are available to any person who 
pays a prescribed fare and meets other availability requirements, such as the Americans with Disabilities Act of 1990 (ADA). 
Charter and school bus services are not considered public transportation because they serve specific groups of people and 
cannot be used by people not belonging to these groups. Service must be open to the general public, not only to specific 
categorical groups, such as school children.  

NTD reporting is a requirement for recipients and beneficiaries of Section 5307 Urbanized Area Formula Program (UAF) and 
Section 5311 Other Than Urbanized Area Formula Program of the Federal Transit Act (see the NTD Rural Reporting Manual 
for Section 5311 requirements). Under the Urbanized Area Formula Program (UAF), the term public transportation usually 
applies to area-wide services primarily within an urbanized area (UZA). Since Congress uses NTD performance data in 
statutory formulae to apportion FTA funding to UZAs, the NTD can only contain public transportation or transit data. 
Transportation service that is not public transportation service should not be reported to the NTD. Public transportation is 
predominantly commuter service. For the purposes of the NTD, a commuter is a transit rider that travels back and forth 
during the same day primarily within a UZA. Intercity bus services are excluded under the Urbanized Area Formula Program 
(UAF). However, some commuter rail and ferryboat intercity services are permitted, if a person travels and returns on the 
same day.  

For NTD reporting, FTA reserves the right to evaluate transit services as public transportation by requiring a written 
description of the transit services including availability and public notification of the availability of service, compliance with 
Americans with Disabilities Act of 1990 (ADA) requirements, service area maps, schedules and public timetables, and other 
materials as necessary. In the case of new modes or significant expansion of transit services, FTA reserves the right to 
request passenger surveys. 

Mode 
A variety of transit modes are operated in the United States. The NTD reporting system groups transit modes into two broad 
categories — rail modes and non-rail modes — as follows: 

Rail Non-Rail 

Alaska railroad (AR) 
Automated guideway (AG) 
Cable car (CC) 
Commuter rail (CR) 
Heavy rail (HR) 
Inclined plane (IP) 
Light rail (LR) 
Monorail (MO) 

Aerial tramway (TR)  
Bus (MB) 
Demand response (DR) 
Ferryboat (FB) 
Jitney (JT) 
Publico (PB) 
Trolleybus (TB) 
Vanpool (VP) 
Other (OR) 

Type of Service 
Public transportation can be provided in two ways: 
1. Directly operated (DO) service, in which the NTD reporting agency, usually the public transit agency, uses its own 

employees to operate the transit vehicles and provide the transit service. 
2. Purchased transportation (PT) in which the NTD reporting agency, usually the public transit agency, contracts with a 

public or private provider to operate the transit vehicles, employs the operators, and provide the transit service.  

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G373
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G385
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G371
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G367
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G423
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G423
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G79
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G439
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G29
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G167
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G503
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G215
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G29
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G385
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G284
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G123
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G306
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Type of service (TOS) is an important element of NTD reporting. On most reporting forms, transit agencies are required to 
report data by type of service (TOS). 

Maximum Service Vehicles 
The maximum service operated during the year is an important determinant of a transit system's size and resulting 
performance. Transit agencies are required to report vehicles operated in annual maximum service (VOMS). 

Vehicles operated in annual maximum service (VOMS) is a count of the revenue vehicles scheduled for the peak day and 
operating period of the peak service season or schedule of the year. The revenue count is the typical number of vehicles 
operated and does not consider the number of vehicles operated on atypical days such as holiday celebrations (e.g., Fourth 
of July), or one-time special events (e.g., World Series celebrations, political conventions). 

Reference Documents 
The FTA Uniform System of Accounts (USOA), Annual Reporting Manual, Glossary of Transit Terms, and Final Rule (CFR 
Part 630) are helpful documents to understand the forms and instructions presented in this manual. You can obtain these 
documents by visiting the NTD Project website at www.ntdprogram.gov or calling the NTD Project Office at (703) 462-5220.

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G524
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G399
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G501
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Internet Reporting — 11 

Overview 

Transit agencies must use the National Transit Database (NTD) Internet Reporting system to provide their data via reports to 
the Federal Transit Administration (FTA). NTD Internet Reporting is the online means for transit agencies to enter, save, 
review and revise data, and submit reports. It provides for timely and accurate reporting as all tasks and requirements for the 
NTD can be fulfilled via this system. 

This section provides Internet Reporting information for the NTD Monthly report.  

What Has Changed from Prior Year 
Column a is now labeled unlinked passenger trips (UPT).  

The system will not allow the creation of monthly forms if the agency has an approved 9 or fewer vehicles reporting waiver. 

Upon submission, the data is subjected to analysis and review with the help of validation checks included in a report 
designed to identify potential problems. These validation checks are included in a report that lists all current issues. Since 
agencies are allowed to make adjustments to data previously submitted during the calendar year, these checks cover all 
months, from January of the current calendar year to the month data is due. Agencies are encouraged to address the issues 
included in this report by either correcting the data or explaining why the reported data is correct. This requirement is based 
on the fact that FTA has a mandate from Congress to administer the National Transit Database which includes developing 
programs and processes to guarantee data completeness and data quality. 

The validation report itself is an editable Word document, and the explanations can be documented in the report itself.  

Form script will flag missing data prior to report submission. Reports can be submitted only if all required data has been 
entered into the MR-20 forms. 

Internet Reporting System Security 
Numerous measures have been taken to ensure that all data entered into the Internet Reporting system are safe and 
available only to those with proper access. The NTD servers and network are secured behind a firewall. The website 
operates the secured web protocol, https, and the entire site is password protected. Additionally, multiple server and 
database protection layers protect the database files. 

Detailed Instructions 

Accessing Internet Reporting 
Internet Reporting is accessed from the NTD Homepage. 

To access Internet Reporting:  
• Connect to the Internet via your Internet service provider (ISP) 
• Verify your Internet browser settings 
• Access the Internet Reporting website at www.ntdprogram.gov 
• Access your transit agency’s NTD report via the Internet Reporting Login link. 

Connecting to the Internet 
Use your Internet service provider to connect to the Internet. Internet Reporting requires a web browser that is at least a 6.x 
version (Internet Explorer 6.0). 

If you don’t have the latest version of the browser, go to Microsoft.com (or any other ISP that you may use, for example: 
Netscape.com) to download the latest version free of charge. 

Verifying Your Internet Browser Settings 
Verify that your browser is set to check for newer versions of stored pages with each visit to the page. 

In Internet Explorer, this is done by accessing Tools > Internet Options > General > Temporary Internet Files Settings > 
Every Visit to Page. 

In Netscape, this is done via Edit > Preferences > Advanced > Cache > Every Time. 
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The National Transit Database Website 

 
The NTD Home Page offers the following information and data for reporters and others interested in the NTD: 
• Internet Reporting Login link. 
• What is the NTD?: An overview of the NTD program, milestones in transit history, how to obtain an NTD ID number and 

an overview of the NTD reporting forms. 
Reporting Manuals 
• Annual Reporting: Access to .html and .PDF versions of the current Annual Reporting Manual, an overview of 

reporting changes and highlights, reporting manual archives, etc. 
• Monthly Reporting: Access to .html and .PDF versions of the current Monthly Reporting Manual, an overview of the 

reporting changes and highlights, reporting manual archives, etc. 
• Safety and Security Reporting: Access to .html and .PDF versions of the current Safety and Security Reporting 

Manual, Newsletters, Safety and Security FAQs, an overview of reporting changes and highlights, reporting manual 
archives, etc. 

• Rural Reporting: Access to the Rural Reporting Manual, an overview of reporting changes and highlights, reporting 
manual archives, etc. 

Data, Publications and Reference Materials 
• NTD Glossary: HTML version of the NTD Glossary of transit terms. 
• NTD Reference Materials: NTD reference materials such as the Uniform System of Accounts, FTA Circulars and 

Federal Register Notices. 
• Access to NTD Data: HTML and downloadable .PDF publications, including the Data Tables, Profiles, National Transit 

Summaries and Trends, as well as NTD databases and historical data. 
NTD Resources 
• FTA / NTD Presentations, Announcements and Updates: FTA / NTD presentations, new and useful information, 

interim updates to reporting requirements, etc. 
• NTD Feedback: The mailing address, telephone number and fax number for the NTD Project site as well as an 

opportunity to provide comments or suggestions regarding the NTD Program.  
• Seminars and Training: NTD Reporting Seminars and In-house Training information and registration 
• Transit Agency Listing by Region and External Links: Contact information for transit agencies reporting to the 

National Transit Database (NTD). Links to:  
• Federal Transit Administration (FTA) 
• FTA Safety and Security Office 
• U. S. Department of Transportation (USDOT) 
• National Transit Library 
• American Public Transportation Association (APTA) 
• Bureau of Transportation Statistics 
• Accessibility. 

12 — Internet Reporting 
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Accessing the Monthly Report  
Click the Internet Reporting Login link to open the Internet Reporting Login page. Enter your user name and password to 
gain access to Monthly Reporting. 

Levels of Access 
Internet Reporting provides four levels of access to the NTD Report:  
1. CEO access: Edit forms (data entry), approve Chief Executive Officer (CEO) Certification and submit report 
2. Contact Person access: Edit forms (data entry) and submit report (administrator) 
3. Editor access: Edit forms (data entry), cannot submit report 
4. Viewer access: View only including forms, issues, notes and correspondence. 

User Names and Password 
The system access level is determined by the user name. The first three characters of the user name define the access level 
and the last four digits represent the transit agency’s NTD ID. There are four types of user names corresponding to the four 
access levels available within the NTD Report: 
1. CEO — CEOxxxx 
2. Contact person — NTDxxxx 
3. Editor — EDTxxxx 
4. Viewer — VWRxxxx. 

Each transit agency is e-mailed this set of user names with a password for each. Transit agencies determine access within 
their organizations and distribute user names and passwords accordingly. 

A user can change his / her password at any time. Refer to Sys Admin: Changing Your Password for additional information 
on this topic. Users should be aware that passwords expire every ninety days.  

The CEO and NTD Contact Person use their individual passwords for all report areas. The CEO and NTD 
Contact person access all reporting areas (Annual, Monthly and Safety and Security) from the Home tab. 

 

Internet Reporting — 13 
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NTD Report Structure 
Monthly Reporting includes the following tabs: 
• Home: The starting point when entering the NTD report. It displays the transit agency’s NTD analyst information and 

any project related announcements. 
• e-File: The e-File screen provides for processing and tracking any special correspondence and auto generated emails. 
• Annual: Access to the Annual reporting modules and forms.  
• Monthly: The NTD contact person is responsible for completing and submitting these two forms. The information is 

used by the NTD to collect monthly information regarding transit service provided by the transit agency. 
• Safety and Security: Access to the Safety and Security forms. 
• Notes: Internet Reporting allows the transit agency to create Form Notes to provide additional information applicable to 

the overall form. Displays all the Form Notes added to the transit agency’s report.  
• Issues: Currently displays only those Issues generated for the transit agency’s NTD Annual report.  
• Reports: Print and export reports. All reports have been developed to allow the transit agency to print each form or 

report without altering print settings to fit a form on the page. The reports listed will vary depending on access level.  
• Communications: The Communications screen lists a record of the report submissions the agency has made to NTD, 

including any comments from the agency and the review status of the report. 
• Sys Admin: Change NTD passwords—CEO, NTD Contact Person, Editor and Viewer. You may only change your 

password. Should you need assistance, contact your NTD analyst. 
• Help: Online version of the Monthly Reporting Manual.  

Home: The Monthly Report Homepage  

 
After completing the logon process you will be taken to the Monthly Report Homepage. Click the Home tab near the top of 
any screen to return to the Home tab from another area. 

 

Monthly: Providing Ridership Data to NTD 
Click on the Monthly tab to open the Monthly screen. This screen provides links to the Monthly forms that your agency is 
required to complete.  

Initially, the Monthly screen only provides access to one form: 
1. Mode Service Operated form (MR-10) 

Review, complete and save the Mode Service Operated form (MR-10) to automatically generate the Ridership Activity 
form(s) (MR-20) for each mode / type of service operated by the agency. 
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Notes: Providing Additional Information 

Creating a Form Note 
To create a form note click on the Add Form Note link at the top right of the form you are editing or viewing. Internet 
Reporting will take you to the Form Notes screen for the specific form. Internet Reporting will pre-fill the mode and type of 
service (if applicable) for which the note is created. The transit agency completes the note comment. 

To save a form note, click on the Save button at the bottom of the screen. To return to the form being edited without saving 
the note, click on the Cancel button. 

Reviewing Form Notes 
Click on the Notes tab to view the Notes Summary screen. You can review the form notes associated with a specific form 
or all form notes for the report. While working in a form click on the Notes tab to display the Form Notes screen for the form. 
The form name and mode / type of service will be displayed just beneath the tabs. 

Editing Notes 
While you are entering and saving Monthly data for any given month, you can edit a note for that month after it has been 
created. Click on the Edit Note link in the far right column on the Notes screen. Once the Monthly data for any given month 
is date stamped, the notes are frozen and cannot be edited. However, if needed, additional form notes can be added. 

Notes are frozen each time the Edit Date button is clicked. If the report is edited and re-dated, the previously 
submitted notes will not be affected. 

Printing Form Notes 
All form notes can be printed from the Reports tab by clicking the All Form Notes link. 

 

 

Communications Summary: Viewing a History of Correspondence with NTD 
The Communications tab gives transit agencies a centralized area in which to view past correspondence with the Federal 
Transit Administration’s (FTA) National Transit Database (NTD) program. In addition, the correspondence view can be 
filtered to show only certain processes or communication types. 
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Sys Admin: Changing Your Password 
The Sys Admin screen provides the ability to change your NTD password.  

All passwords expire every ninety days. You can change your password at anytime on the Sys Admin screen by specifying 
your current and new password. To be valid, a password must be at least eight characters long and contain at least one 
letter and one number. It cannot contain spaces. Passwords are case-sensitive. If you do not update your password within 
the ninety-day term, you will be forced to update your password when you first access the system once the ninety-day period 
has expired. The screen is similar to the one available on the Sys Admin screen and the same password rules apply. 

 

 

Help: Obtaining More Information 
Click on the Help tab to display the Help screen. The Help screen provides access to the 2008 Monthly Reporting Manual 
for additional help in completing the NTD report forms. The Help screen displays the table of contents for the Monthly 
Reporting Manual with links to each section of the manual. 

Tips for Using Internet Reporting 

Navigating Between Screens 
Do not use the browser Back and Forward buttons to navigate between screens. Instead, use the Internet Reporting system 
buttons, tabs and links.  

Saving a Form 
A Save button is provided at the bottom of each Internet Reporting form. When entering information into a form it is strongly 
recommended that you save the form frequently. This will prevent the loss of data if your Internet connection is unexpectedly 
lost. Also, Internet Reporting has an automatic time-out feature which will log you off of the system after a period of inactivity. 
It is strongly recommended that you save your work every 15 minutes. Otherwise, there is a risk that the next action you take 
on the system will result in the closure of the screen displayed in your browser and the loss of any data that you had not 
saved. 
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Printing a Form Report from a Form Screen 
Click on the Print button at the bottom of the form screen to display the report in the Adobe Acrobat Viewer. Click the Print 
button  in the upper left corner of the viewer. Then click the Okay button on the resulting Print window. 

Note: Only forms for 2006 or later will print using the Adobe Acrobat Viewer. Previous years’ forms will print using the 
Crystal Reports Viewer and will function the same as forms printed from the Reports tab. 

Printing a Form from the Reports Tab 
Forms can be printed using the Crystal Reports Viewer. For troubleshooting information refer to the Announcement section 
of the Monthly Report Homepage. 

Downloading the Crystal Reports Viewer 
In order to facilitate printing of forms Internet Reporting utilizes the Crystal Reports downloadable viewer and writer. You will 
be prompted to download the Crystal Smart Viewer for Active X free of charge the first time the print functionality is 
accessed, (a report link is clicked on the Reports tab or the Print button is clicked on a form page). This download occurs 
only once and is absolutely necessary to view or print a report. 
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Mode Service Operated form (MR-10) — 19 

This module contains two forms: 
1. Mode Service Operated form (MR-10) 
2. Ridership Activity form (MR-20). 

The system will not allow the creation of Monthly forms if the agency has an approved Nine or Fewer Vehicles Waiver. 

Mode Service Operated form (MR-10)  

The Mode Service Operated form (MR-10) is completed once at the beginning of the calendar year and revised only if there 
is a new mode and type of service (TOS) added or discontinued during the reporting period. This form is used to identify the 
modes and types of service (TOS) operated by the transit agency. Internet Reporting uses this information to generate the 
appropriate ridership activity forms for the transit agency.  

This form is required for all transit agencies, except those agencies with a Nine or Fewer Vehicles Waiver. 

Ridership Activity form (MR-20)  

The Ridership Activity form (MR-20) collects monthly information regarding transit service provided by the agency. These 
data provide FTA with monthly trends in passenger usage and service levels.  

This form is required for all transit agencies, except those agencies with a Nine or Fewer Vehicles Waiver. 
 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G277
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Mode Service Operated form (MR-10) — 21 

Mode Service Operated form (MR-10) 

Overview 

The Mode Service Operated form (MR-10) is used to identify the modes and types of service (TOS) operated by the transit 
agency. Internet Reporting uses this information to generate the appropriate ridership activity forms for the transit agency. 
This form is completed once at the beginning of the calendar year and revised only if there is a mode added or discontinued 
during the reporting period. 

Reporting Requirements and Thresholds 
All agencies must complete the Mode Service Operated form (MR-10) annually. The exception is transit agencies with a 
Nine or Fewer Vehicles Waiver, who need not complete this form. Forms will not be generated for agencies that have an 
approved Nine or Fewer Vehicles Waiver. 

What Has Changed from Prior Year 
The reporter is allowed to add or delete a mode/type of service. Deletion of a mode requires completion of a form note 
explaining why the mode is being deleted, and the Validation analyst must either approve or deny the deletion. 

Approach 

The Mode Service Operated form (MR-10) is used to identify the modes and types of service (TOS) operated by the transit 
agency. The data reported on this form is used by Internet Reporting to generate the appropriate Ridership Activity forms 
(MR-20) for the transit agency for the calendar year. 

Internet Reporting prepares one set of monthly forms for each mode / type of service (TOS) operated by the transit agency.  

Detailed Instructions 

When the Mode Service Operated form (MR-10) is accessed, use the check-boxes to indicate which modes/types of service 
(TOS) are operated by your agency. Once the form has been saved and submitted, the check boxes are no longer active. 

If you need to add or delete a mode or type of service (TOS) during the report year, use the Add / Delete Mode / Type of 
Service button at the bottom of the screen. Common reasons for a mode / type of service being added or deleted: 
• A mode / type of service (TOS) was discontinued,  
• A mode / type of service (TOS) was inadvertently reported / omitted on the Mode Service Operated form (MR-10), or 
• A new mode / type of service (TOS) began operation during the year. 

Mode  
Transit agencies operate one or more modes of transit service. A mode is a system for carrying transit passengers described 
by specific right-of-way (ROW), technology and operational features.

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G266
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The NTD recognizes the following modes of public transit service: 
 
Aerial Tramway (TR) Non-Rail – Fixed 
Guideway 

A system of aerial cables with suspended 
vehicles. 

Automated Guideway (AG) Rail – Fixed 
Guideway  

An electric railway of guided vehicles that 
is operated with a computer and without 
vehicle operators.  

Bus (MB) Non-Rail – Fixed Guideway 
or Non-Fixed Guideway 

The most prevalent mode in the 
country, and is powered by a motor 
and fuel contained within the vehicle. 

Cable Car (CC) Rail – Fixed Guideway  

A railway propelled by moving cables 
located beneath the street. While popular 
at the turn of the last century, the only 
surviving system is operated in San 
Francisco. 

Commuter Rail (CR) Rail – Fixed 
Guideway 

Typically operated over old freight 
railroad lines and is diesel or electric 
propelled. Usually, the service operates 
between a central city and adjacent 
suburbs. 

Demand Response (DR) Non-Rail – 
Non-Fixed Guideway  

Scheduled in response to calls from 
passengers. Passengers with similar 
origins and destinations are often 
scheduled to ride the same vehicle. 
Many transit systems operate demand 
response (DR) service to meet the 
Federal ADA requirements, and 
expenses and passenger trips are 
reportable for DR. 

Ferryboat (FB) Non-Rail – Fixed 
Guideway 

A mode that carries passengers over a 
body of water using diesel or steam 
powered vessels. 

Heavy Rail (HR) Rail – Fixed Guideway 

An electric railway with exclusive or 
separate right-of-way (ROW) from other 
vehicles or foot traffic. It has high 
passenger carrying capacity and high 
platform loading. Most of the nation’s 
subway services are classified as heavy 
rail. 

Inclined Plane (IP) Rail – Fixed 
Guideway  

A railway operating on steep slopes 
and grades with vehicles powered by 
moving cables.  

22 — Mode Service Operated form (MR-10) 
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Jitney (JT) Non-Rail – Non-Fixed 
Guideway  

Operated on fixed routes using passenger 
cars or vans as demand warrants without 
fixed schedules or fixed stops.  

Light Rail (LR) Rail – Fixed Guideway  
 

An electric railway that operates in mixed 
traffic with automobiles or has grade 
crossings with automobiles. Typically, 
light rail (LR) trains are short and consist 
of one to two cars. 

Monorail (MO) Rail – Fixed Guideway  
 

An electric railway that is suspended 
from or straddles a guideway formed 
by single beam, rail or tube.  

Publico (PB) Non-Rail – Non-Fixed 
Guideway  

Operated over fixed routes, but not on 
fixed schedules. The service is privately 
owned and operated, but is regulated by 
local or state governments.  

Trolleybus (TB) Non-Rail – Fixed 
Guideway  

A bus service operated using an electric 
bus that is powered by a motor drawing 
current from overhead wires using trolley 
poles.  

Vanpool (VP) Non-Rail – Non-Fixed 
Guideway 

A commuting service operating under 
pre-arranged schedules for previously 
formed groups of riders in vans. 

Alaska Railroad (AR) Rail – Fixed 
Guideway 

A special railroad that Congress 
recognized for certain FTA funding that 
operates in Alaska. 

 Other – If none of the choices fits your 
agency, select the category: Other. 
Internet Reporting will display a box for 
you to describe the other mode. 

Multi-Modal Vehicles 
If a vehicle is used for more than one mode, report it under each mode for which it is used and describe the use of the 
vehicle using the Add Form Notes link.  

When all data have been entered into the form and verified for accuracy, click on the Submit Report button to generate the 
required forms.  

Mode Service Operated form (MR-10) — 23 
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Form Notes 
A Form Note can be attached to any form to explain unusual circumstances or data discrepancies that impact the data being 
submitted to NTD. Use the Add Form Note link for relevant information to the form. Click on the Add Form Note link at the 
top of the screen and enter your note on the Notes screen. You can review and / or edit a Form Note from the Notes tab. 

 

Add / Delete Mode / Type of Service 
If the agency adds or discontinues a new mode / type of service (TOS) (directly operated (DO) or purchased transportation 
(PT)), click on the Add / Delete Mode / Type of Service button at the bottom of the form. A new screen will appear. Click on 
either the Add or Delete Mode / Type of Service button depending on whether a mode / type of service (TOS) is being 
added or discontinued. Select the mode and type of service from the Drop-Down boxes for the correct line and enter either 
the new service start date or the out of service date. Save the form by clicking on the Save button. A form note must be 
created to explain why the mode/type of service needs to be added or deleted. The Validation analyst will either approve or 
deny the change.  

24 — Mode Service Operated form (MR-10) 
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Mode Service Operated form (MR-10) — 25 

Line by Line Instructions 
Completing the Mode Service Operated form (MR-10)  

From the Monthly tab, click on the Mode Service Operated form (MR-10) link.  

Form Level Help: Click on the Help tab at the top of the screen for form level help. A form note can be attached to any form. 
Use the Add Form Note link for relevant information to a specific field, to the entire form or to multiple forms. Click on the 
Add Form Note link at the top of the screen and enter your note on the Notes screen. You can review and / or edit a form 
note from the Notes tab. Form notes can be edited or revised until the form is Saved after which new form notes can be 
added.  

Saving or Closing the Form 

Click on the Submit button to save and submit the form. Click on the Close button to close the form without saving.  

Completing the Form 

Lines 1 - 17, column a: Directly Operated (DO) - Vehicles Operated in Maximum Service (VOMS): Select the Check-Box(es) 
to indicate which modes are directly operated by the transit system. Select Other if none of the above apply and describe the 
Other mode in the Describe Other field that appears on the form. 

Lines 1 - 17, column b: Purchased Transportation (PT) - Vehicles Operated in Maximum Service (VOMS): Select the Check-
Box(es) to indicate which modes are directly operated by the transit system. Select Other if none of the above apply and 
describe the Other mode in the Describe Other field that appears on the form. 

Adding a Mode / Type of Service 
• From the Monthly tab, click on the Mode Service Operated form (MR-10) link. 
• Click on the Add / Delete Mode / Type of Service button to enter new service. 
• In the new window, click on the Add Mode / Type of Service button. 
• Column a: Mode. Select the mode that your agency has begun operating from the Drop-Down menu. 
• Column b: Type of Service. Select the type of service (TOS) that your agency has begun operating from the Drop-Down 

menu. 
• Column c: New Service Start Date. Enter the date that the new mode / type of service (TOS) began operating. 

Deleting a Mode / Type of Service 
• From the Monthly tab, click on the Mode Service Operated form (MR-10) link. 
• Click on the Add / Delete Mode / Type of Service button to delete an existing service. 
• In the new window, click on the Delete Mode / Type of Service button. 
• Column a: Mode. Select the mode that your agency has stopped operating from the Drop-Down menu. 
• Column b: Type of Service. Select the type of service (TOS) that your agency has stopped operating from the Drop-

Down menu. 
• Column c: Out of Service Date. Enter the date that the mode / type of service (TOS) was taken out of service. 
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Ridership Activity form (MR-20) 

Overview 

Reporting Requirements and Thresholds 
Monthly ridership activity information is collected by mode and type of service (TOS). These data provide FTA with monthly 
trends in passenger usage and service levels.  

Reporters must enter their data by the end of the month following the month for which data is being reported, i.e., January 
data is submitted by the last day of February.  

What Has Changed from Prior Year 
Column a is now labeled Unlinked Passenger Trips (UPT). 

The system will not allow data to be entered for a new month until the prior months have been submitted.  

Any zero data will have to be explained by the agency via the e-File tab. 

Clarification for the Edit Date button functionality. Once the data has been entered on the Ridership Activity form (MR-20), 
the reporter must click the Edit Date button and then click the Save button to ensure that the information is submitted 
properly. 

Added form scripts to notify the reporter of missing data prior to submission. 

Approach 

There are two Ridership Activity forms (MR-20) tailored for: 

1.  Rail 

2. Non-rail. 

The Ridership Activity form (MR-20) is used to report monthly data by mode and type of service (TOS) for the revenue 
vehicles used to provide transit service. The data include: 
• Service consumed (unlinked passenger trips (UPT)) 
• Service supplied (actual vehicle (passenger car) revenue miles (VRM) and hours (VRH)) 
• Passenger cars in operation / vehicles operated in maximum service (VOMS) 
• Number of regular service days operated. 

The data items in this form are similar to the annual data reported on the Service form (S-10). The data reported on the 
Ridership Activity form (MR-20) must be consistent with the annual data reported in the Service form (S-10). 

Detailed Instructions 

Data fields for future months will not appear until the prior month’s data has been submitted. As the form is being completed, 
changes should be saved by clicking the Save button frequently.  

When all data have been entered for a particular month and the data have been verified for accuracy, the month’s data 
should be date stamped by clicking the Edit Date button at the end of the row. The date under the Submit Date column 
should reflect the current date. Next click on the Save button at the bottom of the form to save the data. If you do not click on 
the Save button at the bottom of the form, the data will not be saved. Any change to a prior month’s data takes effect only 
after the Edit Date button is clicked and a submit date shows in the column for Submission date. The reporter will be notified 
of any missing data prior to the submission of the NTD Monthly report. 

Any zero data will have to be explained by the agency via the e-File tab. 

To close the form, click on the Close button to return to the Monthly tab. The submit date is the date that the user last 
updated and saved data for a particular month. Monthly data can be updated, date stamped and saved until the end of 
February of each year, after this time revisions must be done through your Monthly analyst. 

To revise data for prior months, enter the data in the appropriate cell for the month being revised. Click on the Edit Date 
button at the end of the row. The date under the Submit Date column should reflect the current date. Next, click on the Save 
button at the bottom of the form. To close the form, click on the Close button to return to the Monthly tab. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G266
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G498
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G399
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G399
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G502
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G21
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G20


2008 Monthly Reporting Manual 

28 — Ridership Activity form (MR-20) 
 

Unlinked Passenger Trips  
Unlinked passenger trips (UPT) are the number of passengers who board public transportation vehicles. Passengers are 
counted each time they board vehicles no matter how many vehicles they use to travel from their origin to their destination. 

FTA requires 100 percent counts if available and reliable. If not available or reliable, the application of a methodology 
developed for estimating monthly trips is allowed and does not need to be the same as the one used in annual reporting. 
However, the two methodologies cannot be biased in relation to each other. 

Actual counts (100 percent sample) involve counting passengers each time they board a vehicle. This method is generally 
applicable to smaller systems, but its use is not precluded by a system’s size.  

If the transit agency uses a sampling method, the total unlinked passenger trips (UPT) for a specific month should be 
estimated using the sample data collected during the month and the same procedure that the transit agency uses to estimate 
annual unlinked passenger trips (UPT). This approach may not meet FTA’s confidence and precision levels for annual data 
(+-10% precision for a 95% confidence level), but does meet FTA’s requirements for a good faith effort for reporting monthly 
data on the Ridership Activity form (MR-20). 

If the transit agency changes its sampling procedure, it should revise its reported unlinked passenger trips (UPT) for the 
current year and the prior year using the new methodology. The transit agency should contact their Validation analyst for 
assistance in reporting the revised estimates for the prior year. 

Other estimation methods not necessarily based on sampling can also be used. For example, monthly fare box revenues 
can be used, provided that bias correction factors are factored into the method to account for trips for which no fare box 
revenues are recorded, or a large number of intra-modal transfers skews the relationship of trips and fare box revenues. 
 

Example 2 — Transit Agency Makes 100 Percent Count for Bus (MB) to Calculate the Total Unlinked 
Passenger Trips for the Month 
Day Number of Days in Month Total Unlinked Passenger Trips 
Weekday 21 46,956 
Saturday 5 5,987 
Sunday 5 3,125 
Solution: The total unlinked passenger trips for weekday, Saturday, and Sunday are summed to arrive at the total unlinked 
passenger trips for the month. 
Total 31 56,068 

The transit agency reports 56,068 for total unlinked passenger trips (UPT) for the month. 

If the transit agency uses an estimation method to report the data and not 100 percent counts, this method does not need to 
be the same procedure that the transit agency uses to estimate annual unlinked passenger trips (UPT). However, the two 
methods cannot be biased in relation to each other. The annual data and the cumulative monthly data for the agency’s fiscal 
year should be very close, if not identical.  

Actual Vehicle (Passenger Car) Revenue Hours and Miles  
Actual vehicle revenue hours (VRH) and miles (VRM) are incurred when non-rail service is available to the general public. 
These are the miles and hours traveled by vehicles in carrying passengers, plus layover/recovery time. It does not include 
the miles and hours for items such as deadhead, charter services, school bus service, operator training or maintenance 
testing. For rail service, the data are reported in terms of passenger car revenue hours and miles. 

Vehicles Operated in Maximum Service 
This is the number of revenue vehicles/passenger cars operated to meet the maximum service requirement during the 
month. In most instances, this is the number of scheduled vehicles/passenger cars since most transit agencies have 
sufficient vehicles/passenger cars to operate the scheduled service. Vehicles operated in maximum service (VOMS) / 
passenger cars in operation exclude atypical days or one-time special events. 

This data item is different than the vehicles operated in annual maximum service (VOMS) that is reported on the Service 
form (S-10). The difference between the forms is the time period used in the definition— a month in the Ridership Activity 
form (MR-20) and a fiscal year in the Service form (S-10).  

Number of Regular Service Days Each Month 
Enter the number of days during the month that the agency operates normal weekday service. Saturday, Sunday (holiday), 
reduced or special event service should not be included. This column will only accept a value between 0 and 23. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G502
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G373
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G20
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G21
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G284
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G226
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G110
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G81
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G420
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G385
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G345
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G346
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G399
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G524
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Form Notes 
A Form Note can be attached to any form to explain unusual circumstances or data discrepancies that impact the data being 
submitted to the NTD. Use the Add Form Note link for relevant information to a form. Click on the Add Form Note link at 
the top of the screen and enter your note on the Notes screen. You can review and / or edit a Form Note from the Notes 
tab. 
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Line by Line Instructions 
Completing the Ridership Activity form (MR-20) 

From the Monthly screen, click on the Ridership Activity form (MR-20) link for the applicable mode / type of service (TOS).  

Complete the Ridership Activity form (MR-20) following the instructions in this section. Data fields for future months will not 
appear until the 1st of the following month (i.e., February will not be available until March 1). 

Form Level Help: Click on the Help tab at the top of the screen for form level help. A form note can be attached to any form. 
Use the Add Form Note link for relevant information to a specific field, to the entire form or to multiple forms. Click on the 
Add Form Note link at the top of the screen and enter your note on the Notes screen. You can review and / or edit a form 
note from the Notes tab. Form notes can be edited or revised until the form is Date Stamped and saved after which new 
form notes can be added. 

Saving and Closing the Form: To save your data, click the Save button at the bottom of the form. If you do not click the 
Save button prior to closing the Ridership Activity form MR-20, your data will be lost. You will not be able to save data for 
any month if there are empty data fields for that line. This procedure is followed each month, or each time you return to a 
prior month to revise data.  

Rail Modes  
• Lines 01-12, column a: By Month - Unlinked Passenger Trips (UPT). Enter the number of unlinked passenger trips 

(UPT) (need not be audited). 
• Lines 01-12, column b: By Month - Passenger Car Revenue Hours. Enter the number of actual passenger car revenue 

hours (data need not be audited). 
• Lines 01-12, column c: By Month - Passenger Car Revenue Miles. Enter the number of actual passenger car revenue 

miles (data need not be audited). 
• Lines 01-12, column d: By Month - Passenger Cars in Operation. Enter the number of passenger cars in operation (data 

need not be audited). 
• Lines 01-12, column e: Number of Regular Service Days each Month. Enter the number of days (0-23) during the month 

that the agency operates normal weekday service. Saturday, Sunday (holiday), reduced or special event service should 
not be included. 

• Lines 01-12, column f: By Month - Edit Date. When all data have been entered for a particular month and the data have 
been verified for accuracy, the month's data should be date stamped by clicking the Edit Date button for that row. The 
submit date is the date that the user last updated data for a particular month. This procedure is followed each month, or 
each time you return to a prior month to revise data. 

Non-Rail Modes 
• Lines 01-12, column a: By Month - Unlinked Passenger Trips (UPT.) Enter the number of unlinked passenger trips 

(UPT) (need not be audited). 
• Lines 01-12, column b: By Month - Vehicle Revenue Hours (VRH). Enter the number of actual vehicle revenue hours 

(VRH) (data need not be audited). 
• Lines 01-12, column c: By Month - Vehicle Revenue Miles (VRM). Enter the number of actual vehicle revenue miles 

(VRM) (data need not be audited). 
• Lines 01-12, column d: By Month - Vehicles Operated in Maximum Service (VOMS). Enter the number of vehicles 

operated in maximum service (VOMS) (data need not be audited). 
• Lines 01-12, column e: Number of Regular Service Days each Month. Enter the number of days (0-23) during the month 

that the agency operates normal weekday service. Saturday, Sunday (holiday), reduced or special event service should 
not be included. 

• Lines 01-12, column f: By Month - Edit Date. When all data have been entered for a particular month and the data have 
been verified for accuracy, the month's data should be date stamped by clicking the Edit Date button for that row. The 
submit date is the date that the user last updated data for a particular month. This procedure is followed each month, or 
each time you return to a prior month to revise data. 
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